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General Information

Lightning Works 300 Description

The BTD-300 Lightning Warning System detects the presence of lightning flashes within 85km
(53 miles) of the sensor and warns of the potential for overhead lightning even before the first
lightning flash occurs. The Lightning Works 300 software provides a user interface for
displaying information and operating the sensor. A server directly interacts with the sensor,
connecting to clients via IP based communications. A client may be run local to the server, or
remotely if a network connection exists. Use of internet connectivity allows for BTD systems
to be observed around the globe.

An optional Lightning Works Messenger service is available to provide SMS and email alerts
based on thunderstorm detection.

Prerequisites

The following is required for operation of the Lightning Works Software BTD-300:

BTD-300 or BTD-350 connected to a workstation
A workstation running Windows 10/11

Lightning Works 300 Full Install.zip

Licence Activation Code. See section 1.3.2.3.

o NOTE:

| The Lightning Works Software is not compatible with 32-bit computers.

Customer SatisFaction

At Senseca we set our standards high and only your complete satisfaction is acceptable to us.
If you believe your experience has not met these standards, we would be grateful if you would
contact us, so we can discuss any issues you may have. We are also pleased to hear of any
positive experience.

After Sales Support

Senseca offers support by telephone and email for the lifetime of our products, even if there
has been a change of ownership, so please get in touch if you require help. Similarly, if you
have any questions about your new equipment, we are only a mouse-click or telephone call
away. Our contact details are given below. For your convenience our contact details are also
on the label fixed to your equipment.
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Contacting Senseca

If you would like technical assistance, advice or you have any queries regarding the operation
of the sensor please do not hesitate to contact us.

Contact us through our web site: www.senseca.com

Contact us by telephone on:  +44(0)1275 847787

Contact us by email at:  info.bristol@senseca.com

If you bought your system from a local agent, you may wish to contact them in the first
instance. No matter how you got your system Senseca is here to help.

Licences

Lightning Works Licence

BTD Lightning Works software remains the property of Senseca and is protected by
appropriate copyright law and international treaty provisions. The Licensee is granted the right
to use the software, but not to de-compile or to in anyway alter the composition of the
software. The software contains information of commercial value and worth to Senseca.

Google Maps End User Licence

The BTD Lightning Works software uses Google Maps/Google Earth services to provide the
map display. To install the Lightning Works software, it is necessary to accept the terms of the
Google  Maps/Google  Earth  Additional Terms of Service described at
https://maps.google.com/help/terms_maps.html and Google Privacy Policy at
https://www.google.com/policies/privacy/.

Data Privacy

Other than described in the Google Privacy Policy as described, the Lightning Works software
has no data privacy implications.
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1 LIGHTNING WORKS SOFTWARE

11 Introduction

The Lightning Works software allows up to five users to interact with the BTD.

The Lightning Works software has three parts, a server which runs in the background to
communicate with the BTD, a server admin to configure server, and a client to view or control
the system. The client can be run on any computer connected to the server computer via a
network, this includes over the internet. Up to five clients may be connected to one server
allowing for multiple users to monitor one BTD.

The information provided in this manual describes how to install and operate the software.

The Lightning Works for the BTD-300 requires a licence which can be purchased from Senseca
UK.

1.2 Installation

The installation of the Lightning Works software is split into three parts:

- Server Installation
- Server Admin Installation
- Client Installation

Each of the installers are located in the Lightning Works 300.zip folder found on the BTD-300
product page. Download the zip file and extract the contents.

Prior to installation ensure any previous versions have been uninstalled.

1.2.1 Installing Lightning Works Server Software

The server must be installed on the computer that is connected to the BTD.

To install the Lightning Works Server software, follow the steps below:

1. Double click on the Lightning Works Server300 Setup application to start
installation.

2. Toinstall the server software, you must accept the End User licence terms and
conditions. Please read the licence terms and check the agree box to proceed
with installation.
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3. When the software has successfully installed you will see the following
window. Note, for the software to start you must restart your computer.

¥

@ Lightning Works Server300
SERVER

Installation Successfully Completed

Close

The server software runs as a service on your computer so does not have a program icon. The
server software will start automatically whenever the computer is started.
1.2.1.1 Uninstalling the Lightning Works Server Software

To remove the Lightning Works Server software, select Programs and Features in your
computers Control Panel. Locate the Lightning Works Server entry in the list and click on it.
Use the Uninstall option at the top of the list to remove the server software.

o Note:

| Uninstalling the Lightning Works Server will permanently delete all saved thunderstorm data.

1.2.2 Installing the Lightning Works Server Admin Software

The Lightning Works Server Admin must be installed on the same computer as the server.

To install the Lightning Works Server Admin software, follow the steps below:

1. Double click on the Lightning Works Server Admin300 Setup application to
start installation.

2. Toinstall the client software, you must accept the End User licence terms and
conditions. Please read the licence terms and check the agree box to proceed
with installation.

3. When the software has successfully installed you will see the following
window and the Lightning Works Server Admin program icon will be added to
the desktop and start menu.
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Gl

Lightning Works Server Admin300

Installation Successfully Completed

Close

The software is now ready to use.

1.2.2.1 Uninstalling the Lightning Works Server Admin Software

To remove the Lightning Works Server Admin software, select Programs and Features in your
computers Control Panel. Locate the Lightning Works Server Admin entry in the list and click
on it. Use the Uninstall option at the top of the list to remove the client software.

1.2.3 Installing the Lightning Works Client Software

The Lightning Works Client may be installed on the same computer as the server, or a computer
which is connected to the server computer over the network. This may be a local network or
can be over the internet provided both computers have internet connectivity. To install the
Lightning Works Client software, follow the steps below:

1. Double click on the Lightning Works Client300 Setup application to start
installation.

2. Toinstall the client software, you must accept the End User licence terms and
conditions. Please read the licence terms and check the agree box to proceed
with installation.

3. When the software has successfully installed you will see the following
window and the Lightning Works Client program icon will be added to the
desktop and start menu.

u

Lightning Works Client300

Installation Successfully Completed

Close

Page 8 of 31



Lightning Works 300 - Lightning Warning System 108341.00B

The software is now ready to use.

1.2.3.1 Uninstalling the Lightning Works Client Software

To remove the Lightning Works Client software, select Programs and Features in your
computers Control Panel. Locate the Lightning Works Client entry in the list and click on it.
Use the Uninstall option at the top of the list to remove the client software.

1.3 Configuring the Lightning Works Software

The system can be configured once the Lightning Works server, server admin and client
software have been installed. The BTD should be powered and connected to the computer
running the server. Note, this document applies to a singular BTD connected to the server, for
multiple BTD configurations please contact Senseca.

1.3.1 Server Configuration

By default, the server will start on Windows startup and run in the background as a service.
The server will automatically attempt to connect to the BTD and client.

If a remote connection is required, see section 1.3.1.1

If you are connecting on a local network proceed to section 1.3.2.

1.3.1.1 Remote Connection

If connecting the Client to the Server over the internet the following configuration is required
from the server:

- Subnet

- Port

- Add User

Open the Lightning Works Admin software and configure the below:

Subnet

By default, the Server is set to automatically choose a subnet. To ensure remote access either
select “Use All Subnets” or select the “Advanced” tickbox and add a user selected Subnet. The
subnet of the internet access point to the server must be used.

Port

The default port is set to 25367. The user must ensure the firewall allows connections through
the port. The user may change the port by selecting “Advanced” and reallocating the port
number.

Add User

To remotely connect a Client to the Server a User must be added with a username and
password. Select the “Users” tab and add a user, this can be any name and password of
choosing. Multiple users may be added.
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1.3.1.2 Ethernet Virtual COM Port

The BTD ethernet connection creates a virtual COM port. By default, the software will
automatically detect the BTD and connect without user interaction. It is possible for the user
to allocate the IP address of the BTD to a fixed COM port on the computer in instances where
multiple BTD sensors are on the same network. To do so open the Lightning Works Server
Admin300 software and navigate to “Manage Network Com Ports”.

LIGHTNING WORKS SERVER ADMIN

Service Status: Stopped
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This is present a window which lists the available networked devices. To assign a COM port:

Click on the relevant network address

Click on the Com Port dropdown and assign a COM port number
Click “Assign Networked COM Port”

Exit the window

1.3.2 Client Configuration

When opened the Lightning Works Client300 will automatically search for any available
Lightning Works Server available on the network. If installed on a local network the Lightning
Works system should now be connected.

This section also contains information for:

- Remote Connections
- Map Configuration
- Licencing (Mandatory)

For general operation and additional settings see section 1.4.
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1.3.2.1 Remote Connections

To setup a remote connection to a server navigate to the “Network” settings under File >
Network.

Under the Network Settings window select the option “Specify Server Address” and use the
address of the remote server. This can be either an IP address or a hostname if using a DNS
service.

Note, the port is set to 25367 by default. To change the port, select “Advanced Options” and
enter the number of the port, this should match that of the server.

In the Network Settings window, the user details stored in the server must be input under
“Login Details”. Without user details the remote connection will fail.

Disconnect Disconnect before changing settings
Specify Server Address [ Advanced Options
|
Server Address /
60.19.39 | |  tognpetais |
Disconnected
Connect Cancel Reset to Defaults

Once all settings are configured for remote click “Connect”.

1.3.2.2 Map Configuration

The Lightning Works Client overlays the thunderstorm range bands on a map. The origin of the
map must be set by the user using the longitude and latitude coordinates. To set the
coordinates see section 1.4.3.5. By default, the coordinates are set to Senseca UK.

For systems without an internet connection, maps can be generated from a client with internet
connection or provided by Senseca UK. For further information contact Senseca.

1.3.2.3 Licencing

The BTD Lightning Works Client must be licenced. A licence key may be obtained on purchase
of the BTD or requested at a later date. To request a licence key navigate to Help>About on
the Client. Copy the BTD serial number and send to info.bristol@senseca.com along with the
details of your request. A quotation will be provided.

N Client Version: 1020
r' Client Date: 2026-01-29 11:30:00Z
Client Part Number: 100425.02A

Copyright: Copyright © SENSECA 2026
Server Version: Not available
BTD Version: Not available
[ oK | BTD Serial Number: Not available Copy to Clipboard

Activation Code
Cancel Check Code

Activation Status: Request code from BIRAL
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On purchase, the activation key will be given to the customer. Enter the code into the
Help>About window and press “Check Code”. If accepted the licence activation status will
change to “Activation Code Accepted”.

Note, the licence code is applicable to the BTD and not the software itself. The same licence is
required for each client connected to the BTD. If multiple BTD sensors are used, a licence is
required for each of these.

1.4 Lightning Works Operation

1.4.1 Main Display

Following installation and configuration the Lightning Works system should be configured and
connected to the BTD. On Client start up the “Main” page will be displayed. Here the following
is observed:

- Lightning Map

- Lightning Status (Alert, Warning, Caution)
- Lighting History (Past 60 Minutes)

- System Status

- Activity Log

Lightning Map Lightning Status Activity Log

B Lightning Works 300
File  Help

Main  User Settings Administrator

Alert
Z LIGHTNING WORKS 300
Activity Log
: Bannau j]—", : Cheltenham Warkp
y/Brycheiniog =%\ _Glgucestero .
National - Cotswolds
Caution
: Swindon
Bridgend 2
Exmoor‘
NaXional!Park
Google’ Map data ©2024 Google -
Flashes in last 60 Minutes System Status
37-83 km 19-37km 9-19 km 0-9km —
Total 0 (] 0 0 Connection System Status TR
No Direction ) 0 0 0
Version: 1.0.0.0 | Server Connection: Connected | BTD Connect tion: Connect ted \
Lightning History System Status

Note any lightning activity will cause the Client to jump to the front of the screen by default.
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1.4.1.1 Lightning Map

The Lightning Map display shows a map centred around the coordinates from the user, see
section 1.4.3.5 for details on setting the coordinates. The map is overlayed with the
corresponding lightning range detection bands set by the user, see section 1.4.3.3 for details
on adjusting the range bands. Without a direction finder fitted to the BTD the direction of the
lightning is unknown and therefore an entire range band will illuminate. With a direction finder
the flash is shown as a dot on the map and the illumination is confined to an octant within the
range band. Where a flash has been detected but the direction finder has been unable to
identify a heading the entire range band will illuminate.

1.4.1.2 Lightning Status
The Lightning Status is classified between:

- No lightning or pre-lightning activity detected
- Caution - Lightning Activity detected in Distant range band OR
Charged Precipitation pre-warning overhead

- Warning - Lighting Activity detected in Vicinity range band OR
Strong Electric Field pre-warning

- Alert - Lightning Activity detected in Overhead range band

The range bands are configurable by the user, see section 1.4.3.3.

When lightning activity is detected, the status will illuminate and there is an audible warning
from the computer. It is possible for the user to “Mute” the sound temporarily using the Mute
buttons.

1.4.1.3 Lightning History

The lightning history can be quickly viewed by the user. This details the number of flashes in
each range band giving a total, a separate row details how many from the total were identified
without a direction. For a BTD without a direction finder both rows will show the same
information, for BTD systems fitted with a direction finder this allows the user to view the
effectiveness of the direction finder.

1.4.1.4 System Status Indicators

There are two indicators visible to the customer for system connectivity, and BTD status. The
system connectivity indicator status shows:

e Solid Green - Both Client to Server connection is good, and Server to BTD
Connection is good.

e Flashing Green - Client to Server connection is good, Server is not connected to
the BTD

e Flashing Red - Client is not connected to Server
The BTD status indicator shows:

e Green - BTD Connected, all systems functioning correctly

e Flashing Red - BTD Connected, system fault detected. See section 1.4.3.17 for
details.

e Grey - BTD Disconnected
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1.4.1.5 Activity Log

The activity log details all detected events by the BTD. This includes flashes, charged
precipitation and strong electric field events. Lightning activity is saved to a database which
may be accessed by the user, see section 1.4.2.7.

1.4.2 User Settings

The User Settings tab within the Lightning Works Client allows the user to:

- Change Audible tone settings for the Caution, Warning and Alert status

- Modify the Mute button duration for the Caution, Warning and Alert status
- Toggle the Jump to Front of screen option

- Set the Lightning History duration

- Select the unit of measurement for distance (e.g. km or miles)

- Change the user language

- Export data

- Modify startup settings

ExportData

Export historical BTD data for this day

01 November 2024 B~ Expot

+ Minwes 10 * Minutes Startup Seftings

Jump to front- makes the window appear when awaming or alertis tiggered Startprogram automatically on startup

— Start program minimised when starling

Enabled U automatically

Flash Display Settings Units Language

Maximum flash count display time Distance Language

50 2| Minutes m - English

Version: 1000 | Server Connection: Connected | BTD Connection: Connecte d

1.4.2.1 Audible Tone Settings

Each of the lightning statuses, Caution, Warning and Alert can be setup with different audible
tones or disabled. There are four tones to choose between:

- Thunder
- Alarm Beep

Alarm Short

Alarm Siren
For changes to take effect the Save button must be pressed.
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1.4.2.2 Mute Button Duration (Snooze Time)

The mute button duration for the lightning status (shown on the main page, section 1.4.1.2) is
user configurable.

For changes to take effect the Save button must be pressed.

1.4.2.3 Jump To Front

By default, the Lightning Works Client will jump to the front based on lighting activity or a
system fault. To toggle this feature, use the checkbox and press the save button for changes
to take effect.

1.4.2.4 Lightning History Duration

The lightning history duration displayed on the main page can be modified. For changes to take
effect the Save button must be pressed.

1.4.2.5 Distance Unit of Measurement

The unit of measurement for distance can be changed by the user. Note, this will affect all
settings and displays where the unit of measurement is detailed. Where range bands have been
setup, the settings will automatically adjust to suit the new unit of measurement. For changes
to take effect the Save button must be pressed.

1.4.2.6 Language Selection

The Client language may be changed between the following:

- English

- Dutch

- Chinese

- Romanian
- ltalian

- French

- Spanish

- Japanese

- Polish
The text will change for all aspects of the Client and will take effect when the Save button is
pressed.

1.4.2.7 Export Data

The user can export data from the Server from any selected date. This data will contain flash
information and pre-warning activity. Note, data will only be available from dates when the
Server was connected to the BTD. Data can be exported from dates where the Client has not
been run, but the Server remained running and connected to the BTD. For further information
on exported data and the format see section 3.

1.4.2.8 Startup Settings

The Startup Settings of the Client interface can be modified by the user. For changes to take
effect the Save button must be pressed.
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1.4.3 Administrator

The Administrator tab allows the user to change core parameters of the BTD. Only competent
users should access this page. By default, the password protection is disabled. To enable
password protection the user must change the password, see section 1.4.3.1

Only one administrator may be logged in at once. In systems where multiple Clients are
connected it is important to remember to log out.

On the admin page the user has the ability to:

- Start or Stop the BTD

- Adjust therange bands ©

- Setthe BTD Time ©

- Set the map coordinates ©

- Configure the relay settings ©

- Adjust the sensor sensitivities ©

- Adjust the Flash Warning Settings ©
- Set the Site Correct Factor (SCF) ©
- Testrelays ©

- Reset to Factory Settings ©

- Set the Direction Finder Offset®

- Change administrator password

- Enter the Field Test Unit mode (FTU)
- Perform a Site Calibration

- Save Diagnostic File

- Load Parameter File

Settings marked by @can only be changed when the BTD is stopped. WARNING - Whilst the
BTD is stopped the sensor is not monitoring for thunderstorms.

(i Lightning Werks 300
File Help

Main  User Settings Administrator
Operating Mode Administrator Settings
Hacus i e BT Change Administrator Password
Stop = Changs Password
(] Enable Auto-Administrator

i = Log OF
= = Diagnostics
Start FTU Test Mode
Perfom Site Characteristics
Save Diagnostic File

Load Parameter File

Map Settings
Latitude
51485836

Longitude
2756419
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1.4.3.1 Changing the Administrator Password

By default, the administrator password is admin and the administrator tab is not password
protected. Setting the administrator password back to admin will disable password protection.

To change the Administrator password, click on the Change Password button. A new window
will appear, enter the existing password and then the new password in each of the new
password boxes. To complete the operation, click the update button.

o NOTE:

If the Administrator password is forgotten the only way it can be reset is to reinstall the server software.
Reinstalling the server software will result in a loss of the data archive.

1.4.3.2 Auto-Administrator Function

Whenever the client software is started on a PC with Auto-Administrator enabled the software
will start as an Administrator.

0 NOTE:

Only one Administrator can be active on a BTD system at any time. If another client attempts to log on as an
Administrator or another client set for Auto-Administrator is started Administrator access will be refused.

1.4.3.3 Range Settings

The Range Settings area of the Administrator tab allows the user to set the Overhead, Vicinity
and Distant range bands. The Overhead band cannot be set lower than 1km (1 mile) and the
Distant band cannot be set higher than the maximum range of the sensor. Values of adjacent
bands cannot overlap.

To change the Range Settings, enter the desired values and click the update button.

o NOTE:

Changing the Distant range band causes the scale of the map on the main screen to change. Map updates will
only occur if the computer is connected to the internet.

1.4.3.4 Setting the System Time

The BTD has an internal clock that is used to timestamp each message it sends out and to
control the relay inactive time. To set the BTD clock to the same time as the local PC click on
the Set Time button in the BTD Time area of the screen.

If the BTD time is more than 10 minutes different from the PC time a warning will be displayed
in the BTD Time area of the Administrator tab and a system fault will be generated.
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o Note:

The BTD does not automatically update for daylight saving. If your region uses daylight saving you will have to
manually set the BTD when the clocks change.

1.4.3.5 Map Settings

The administrator can input the coordinates of the BTD installation, see section 1.4.3 for
administrator usage. This will automatically download the map from the internet and display
the BTD at the coordinates.

Offline maps can be generated from the client for installations which are not connected to the
internet. For more information contact Senseca.
1.4.3.6 Relay Settings

The administrator can change the time period for which the relays remain active from the
detection of lightning/pre-lightning.

The administrator can change the timeframes in which the relays are inhibited. For example, if
the thunderstorm warning system is connected to a sounder, this may be disabled during the
night to prevent noise pollution/complaints.

The times are entered in HH:MM:SS format. To never disable the relays, enter 00:00:00 in both
boxes.

For settings to take effect the “Update” button must be pressed.

1.4.3.7 Sensitivities

The BTD sensitivity settings should only be adjusted at the direction of Senseca. These settings
are for adjusting the sensor algorithms when the BTD is installed in a non-standard
environment e.g. at the top of a skyscraper.

By default, all sensitivities are set to 5.

1.4.3.8 Flash Warning Settings

The administrator may configure the number of flashes which must be detected for a distant
flash to be reported by the sensor. As the range increases it is more likely a false detection may
occur. Thunderstorms typically consist of multiple flashes therefore if the user sees false
reports, it is possible to increase this value to a number more than one.

The Warning Delay Time sets the number of minutes of which the number of flashes are
detected over. For example, if the time is set to 15 minutes (default), multiple flashes must be
detected within this timeframe for the sensor to trigger a distant warning.

For settings to take effect the “Update” button must be pressed.

1.4.3.9 Site Correction Factor

By default, the site correction factor is set to 1. The site correction factor allows for the
reported flash range to be calibrated by the user. It is not expected to be changed under typical
usage. See section 2 for more information.

To reset the site correction factor, switch the “Set Value” checkbox and enter the value 1 into
the “Current SCF” field and press “Update”.

1.4.3.10 Relay Test

The operation of the relays on the BTD, and therefore any equipment connected to them, can
be tested using the buttons in the Relay Test section of the Administrator Tab.
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Clicking on the Warning or Alert buttons will switch the relay on, the text on the button wiill
change from Start to Stop. Clicking on the button when the button text is Stop will switch the
relay off.

1.4.3.11 Factory Default Settings

The BTD can be reset to the factory settings using the Reset button in the Reset Factory
Settings of the tab.

1.4.3.12 Direction Finder Offset

If a Direction Finder is fitted to the system, the Direction Finder Offset controls will appear in
the Administrator tab.

Depending on the site where the BTD and Direction Finder is installed it may be necessary to
correct an offset in the directions reported for lightning flashes. The procedure for determining
if a direction correction is necessary is described in the BTD Direction Finder manual.

To enter the Direction Finder Offset click on the Set button in the Direction Finder Offset area
of the Administrator tab. A dialogue box will open, enter the angular offset in whole degrees
and click on the Set button.

1.4.3.13 Field Test Unit Test Mode

The Field Test Unit (FTU) is an accessory used to prove correct operation of the BTD sensor
by simulating thunderstorm activity. The FTU generates signals calibrated for a use with the
BTD sensor factory default settings. The software stores the current settings before testing
and restores them once testing is complete.

Press the “Start FTU Test Mode” button before using the FTU to prepare the BTD. A progress
bar will appear. The button will become green and the text will change to “Stop FTU Test
Mode”. "FTU Test Mode Active” will be displayed across the main page map.

On completion of testing with the FTU, pressing the “Stop FTU Test Mode” button will restore
the BTD to normal operation.
1.4.3.14 Perform Site Characteristics

The BTD should be calibrated on installation using the “Perform Site Characteristics” button.
The sensor monitors the background electric field and stores this into memory. This must not
be done whilst thunderstorm activity or precipitation is in the area.

1.4.3.15 Save Diagnostics File

When contacting Senseca for support the “Save Diagnostic File” button will allow the user to
export all sensor settings to help speed up the support process.

1.4.3.16 Load Parameter File

The user may load in parameter files sent by Senseca using the “Load Parameter File” button.

1.4.3.17 Additional Administrator Controls

When logged in as administrator a “Clear All” button is available within the Lightning Status
zone of the main tab. This button clears all active thunderstorm levels. Extreme caution should
be taken, this button should only be pressed if the user is absolutely certain no danger is
present.
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An additional “Details” button is available within the System Status section on the main page.
This allows the administrator to view detailed information on the system status.

1.4.4 Software and Hardware Revision

The About window, accessible from the Help option in the main menu provides useful
information about the software revisions of the Lightning Works Server and Client and the

firmware version of the BTD.

This information may be needed when upgrading part of your system or installing new

components.

Server Version:
BTD Version:

RC Client Version:

b Client Date:
Client Part Number:
Copyright:

BTD Serial Number:

Activation Code
Cancel

Activation Status:

1020

2026-01-29 11:30:00Z

100425.02A

Copyright © SENSECA 2026

Not available

Not available

Not available Copy to Clipboard

Check Code

Request code from BIRAL
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2 ADJUSTING THE SITE CORRECTION FACTOR

If the BTD is installed at a different height than recommended, on the roof of a building or
close to tall objects, the lightning distance reported by the detector may be inaccurate. If you
notice a systematic difference between actual distance to a storm and distance reported by
your BTD, you will need to re-calibrate the detector by entering the actual and reported
distances to lightning in the Site Correction Factor section of the Administrator tab.

2.1 Finding the Actual Lightning Distance

There are several options to independently find the actual distance to lightning, some of the
best are detailed below. You can find the lightning distance reported by the BTD for each flash
in the Activity Log section of the Main tab or in the data export.

For all the methods discussed below; to increase confidence of the comparison distances, it is
best to compare many flashes and find a typical distance reported by the BTD and the
independent method. Always make sure that you are comparing lightning flashes detected by
the BTD and an independent method which occurred at the same time.

Note, lightning can and typically does occur over many kilometres for a single flash. Due to
differing methods of detection between the BTD and radio-based systems it is not expected
the data will precisely match between these two systems. The BTD sensors are known to pick
up low strength activity such as upstreamers from large structures which can be mistaken for
false positives against less sensitive networks. Therefore, it is vital to select data where the
thunderstorm is detected by both methods.

2.1.1 National Lightning Location Network

Lightning detection by a national lightning location network is usually the best option for
locating lightning flashes as you can see individual flashes in near real-time. This service can
normally be found on your national weather service website or good quality lightning data sites
such as www.lightningmaps.org.

Identify individual flashes that are shown by both the BTD and the lightning location network
and record the distance reported by the BTD and the distance from the BTD to the flash as
shown on the lightning location network. For best results choose a small, localised storm and
average the BTD distance and lightning network distance for several flashes.

2.1.2 \Visible Lightning

When using this method ensure you are adequately protected from lightning.

If lightning is within about 10 km you should be able to see the lightning flash and hear the
thunder, especially at night. To determine the distance to the lightning flash, measure the time
between seeing the flash and arrival of thunder, in seconds. Divide this time by 3 to find the
distance to lightning in kilometres (divide by 5 for miles). For each measured flash record the
distance reported by the BTD. As before average the distances you calculated and those
reported by the BTD over several flashes for best results.

You will find this process easier if you choose a storm that is not too active, so that you do not
confuse individual lightning flashes. Avoid using nearby flashes, closer than 5km, as it is hard
to accurately measure the time in such cases.
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2.2 Entering the Site Correction Factor

In the Actual Distance box of the Site Correction Factor (SCF) area, enter the distance between
the sensor and lightning as found by one of the methods described above. It does not matter
what units you use (kilometres, miles etc.) providing they are the same for both the Actual and
Reported boxes. In the Reported Distance box, enter the distance reported by the BTD for the
same lightning activity, using the same units as for the actual distance (e.g. kilometres). Click
on the UPDATE button to complete the process. Check the value in the Current SCF box has
changed. The BTD has now been re-calibrated to measure the correct distance for your site.
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3 UNDERSTANDING EXPORTED DATA

3.1 Introduction

The Lightning Works software can export archived BTD data in CSV format. Archived data is
always exported as one file for an entire day. If you require data for a longer period, it is
necessary to export multiple files. The file name and location is chosen at the time the file is
saved. Each exported file starts with a header line that describes the data. CSV is a simple text
format where data fields of numbers or letters are separated by a comma (,). CSV files are easily
processed in spreadsheet and word processing applications.

0 Note:

Microsoft Excel removes leading zeros when importing CSV files. This has no impact on the data, but the
messages will not look as described below when displayed in Microsoft Excel.

3.2 Message structure

When operating, the server exchanges messages with the rest of the system every 60 seconds,
unless there is thunderstorm activity in which case messages are exchanged every 2 seconds.
The Lightning Works Server software archives these messages so that the Client can export
the data in a single format.

Archived data is exported in CSV file format with each message on a separate line. The first
line in the file is a header to assist with identifying the fields in subsequent lines. The format of
the data is as follows:

NFDATAS00:,1,2024-09-03,08:51:39,128,1,0,0,0,0,0,1,0,0,0,0,2000-01-

01,00:00:00,0,0,0,2000-01-01,00:00:00,0,0,0,2000-01-01,00:00:00,0,0,0,2000-01-
01,00:00:00,0,0,0

ek Field Name Description
No.
1 Header NFDATA300: No Flash Data Message
FDATA300: Flash Data Message
2 Sensor ID Always 1
3 Date BTD date. DD/MM/YY
4 Time BTD Time. HH:MM:SS
Records the configuration. Displayed as a decimal integer:
5 Configuration O - No Direction Finder

128 - Direction Finder Fitted

0 = Not samplin
6 Operating Mode Ping

1 = Sampling
0 = No Caution
7 Caution State 1 = Caution active

2 = Caution cancelled by administrator
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0 = No Warning
8 Warning State 1 = Warning active
2 = Warning cancelled by administrator
0 = No Alert
9 Alert State 1 = Alert active
2 = Alert cancelled by administrator
0 = All components OK
1 = BTD fault
2 = User Computer fault
4 = Reserved
10 System Health 8 = Reserved
16 = Direction Finder fault
32 = Reserved
64 = Configuration Fault
When multiple faults occur the fault values are added together.
0=0K
11 BTD Status 1=0K
Any value greater than 1 represents a fault condition.
0 = Not connected
12 Direction Finder 1=0K
Status
Any value greater than 1 represents a fault condition.
0 = No relays active
1 = Caution relay active
13 Relay State 2 = Warning relay active
3 = Alert relay active
When multiple relays are active the values are added together.
14 Flash Count The number of lightning flashes detected in the last 2 seconds
0 = No thunderstorm activity detected
1 = Charged precipitation or distant lightning flash detected
15 Warning Indicator | 2 = Corona with or without charged precipitation, or vicinity
lightning flash detected
3 = Overhead lightning flash detected
0 = No thunderstorm activity detected
1 = Corona detected
2 = Charged precipitation detected
16 Warning Flags 4 = Corona and charged precipitation detected
8 = Distant lightning flash detected
16 = Vicinity lightning flash detected
32 = Overhead lightning flash detected
When multiple phenomena occur, the values are added together.
17 Flash 1 date BaDt/eMol\f/l/t\f;\e( first detected lightning flash in the last 2 seconds.
18 Flash 1 Time Time of the first lightning flash detected in the last 2 seconds.

HH:MM:SS
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Flash 1 Time - . o .
19 (Milliseconds) Milliseconds from field 16 of first lightning flash.
20 Flash 1 Distance Distance of first lightning flash detected in the last 2 seconds in
decametres.
21 Flash 1 Directi Value is O to 360 in degrees.
as rection 999 = no direction data available.
Date of the second lightning flash detected in the last 2 seconds.
22 Flash 2 Date DD/MM/YY
. Time of the second lightning flash detected in the last 2 seconds.
23 Flash 2 Time HH:MM:SS
Flash 2 Time e . . .
24 (Milliseconds) Milliseconds from field 21 of second lightning flash.
o5 Flash 2 Distance Distance of second lightning flash detected in the last 2 seconds in
decametres.
26 Flash 2 Directi Value is O to 360 in degrees.
irection
> ectio 999 = no direction data available.
Date of the third lightning flash detected in the last 2 seconds.
27 Flash 3 Date DD/MM/YY
. Time of the third lightning flash detected in the last 2 seconds.
28 Flash 3 Time HH:MM:SS
Flash 3 Time - . - .
29 (Milliseconds) Milliseconds from field 26 of third lightning flash.
30 Flash 3 Distance Distance of third flash detected in the last 2 seconds in decametres.
31 Flash 3 Directi Value is O to 360 in degrees.
irection
4 ectio 999 = no direction data available.
Date of the fourth lightning flash detected in the last 2 seconds.
32 Flash 4 Date DD/MM/YY
. Time of the fourth lightning flash detected in the last 2 seconds.
33 Flash 4 Time HH:MM:SS
Flash 4 Time - . . .
34 (Milliseconds) Milliseconds from field 31 of fourth lightning flash.
35 Flash 4 Distance Distance of fourth flash detected in the last 2 seconds in
decametres.
. . Value is O to 360 in degrees.
36 Flash 4 Direction

999 = no direction data available.
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WARRANTY

The manufacturer is required to respond to the "factory warranty" only in those cases provided by the
Consumer Rights Act 2015. Each instrument is sold after rigorous inspections; if any manufacturing defect
is found, it is necessary to contact the distributor where the instrument was purchased from. During the
warranty period (12 months from the date of invoice) any manufacturing defects found will be repaired
free of charge. Misuse, wear, neglect, lack or inefficient maintenance as well as theft and damage during
transport are excluded. Warranty does not apply if changes, tampering or unauthorized repairs are made
on the product.

The manufacturer repairs the products that show defects of construction in accordance with the terms
and conditions of warranty included in the manual of the product.

TECHNICAL INFORMATION

The quality level of our instruments is the result of the continuous product development. This may lead
to differences between the information reported in the manual and the instrument you have purchased.
We reserve the right to change technical specifications and dimensions to fit the product
requirements without prior notice.

DISPOSAL INFORMATION

Electrical and electronic equipment marked with specific symbol in compliance with
2012/19/EU Directive must be disposed of separately from household waste.
European users can hand them over to the dealer or to the manufacturer when
purchasing a new electrical and electronic equipment, or to a WEEE collection point

designated by local authorities. lllegal disposal is punished by law.
I

Disposing of electrical and electronic equipment separately from normal waste helps to preserve
natural resources and allows materials to be recycled in an environmentally friendly way without risks

C€ 5 RoHS
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